Microsoft® Office

Office 365
## Contents

1. The Fundamentals ........................................................................................................... 6  
   - Overview ...................................................................................................................... 7  
   - Choosing a Subscription ............................................................................................... 7  
   - Subscription Notes ...................................................................................................... 9  
     - System Requirements .................................................................................................. 10  
     - Background ............................................................................................................... 11  
   - Sourcing and Setting up Office 365 ............................................................................ 11  
     - The Office 365 User Account ..................................................................................... 12  
   - Accessing your Account ............................................................................................. 12  
   - The Getting Started Page ............................................................................................ 12  
   - Change your Settings .................................................................................................... 13  
     - Office for Desktop/Laptop ......................................................................................... 14  
   - Standard Desktop Installation .................................................................................... 14  
   - Desktop Setup ............................................................................................................. 15  
     - Office for Mobile Devices ......................................................................................... 16  
   - Mobile Installation ...................................................................................................... 17  
   - Tablet Installation ....................................................................................................... 17  
     - The Fundamentals Review ......................................................................................... 18  
   - The Outlook Web App .................................................................................................. 20  
     - Setting up the Outlook Web App ............................................................................. 21  
   - Desktop Set up ............................................................................................................ 21  
   - Mobile Set up ............................................................................................................. 21  
   - Tablet Set up ............................................................................................................... 22  
     - Outlook Web App for Email ...................................................................................... 23  
     - Outlook Web App for Calendar ............................................................................... 25  
   - Sharing your Calendar ................................................................................................. 25  
     - Outlook Web App for People .................................................................................. 27  
     - Outlook Web App Extras ......................................................................................... 28  
   - Linking and Unlinking Contacts .................................................................................. 28  
   - Voice Input on a Tablet/Mobile Device ......................................................................... 29  
   - Creating Tasks .............................................................................................................. 29  
     - Managing the Outlook Web App .............................................................................. 30  
   - Setting Desktop Options ............................................................................................. 30  
   - Setting Mobile/Tablet Options .................................................................................... 31  
     - The Outlook Web App Review ................................................................................. 32  
   - Using Other Web Apps ............................................................................................... 34  
     - Accessing Other Web Apps .................................................................................... 35  
   - Access from a Mobile or Tablet Device ....................................................................... 35  
   - Access from a Desktop Device .................................................................................... 36  
   - Using the Newsfeed ..................................................................................................... 36
Introducing CustomGuide Courseware

Thank you for choosing CustomGuide courseware as the solution to your training needs. A proven leader in the computer training industry, CustomGuide has been the key to successful training for thousands of students and instructors across the globe.

This manual is designed for computer users of all experience levels. Novice users can use it to learn skills such as formatting text, while advanced users can use it to create their own templates.

All this information is quickly accessible. Lessons are broken down into basic step-by-step instructions that answer “how-to” questions in minutes. You can print a complete 300-page training manual or a single page of instructions.

Here’s how a CustomGuide manual is organized:

**Chapters**
Each manual is divided into several chapters. Aren’t sure if you’re ready for a chapter? Look at the table of contents that appears at the beginning of each chapter. It will tell you the name of each lesson and subtopic included in the chapter.

**Lessons**
Each chapter contains lessons on related topics. Each lesson explains a new skill or topic and contains an exercise and exercise file to give you hands-on experience. These skills can also be practiced using CustomGuide Online Learning.

**Review**
A review is included at the end of the manual. Use these quiz questions and answers to assess how much you’ve learned.

---

**What People Are Saying**

“I have saved hundreds of hours of design time by just picking and choosing what I want from the courseware.”
— Stephanie Zimmerman
Lancaster County Library

“We have been able to customize our training sessions on all Microsoft Office products, at all levels. The ROI of these guides is great.”
— Dawn Calvin
Las Virgenes Municipal Water District

“All in all, the friendliest, most open and easy to understand tutorial of its type that I’ve ever seen.”
— W. Boudville
Amazon.com

“…curriculum that is of high quality, student friendly, and adaptable to the audience.”
— Sherrill Wayland
St. Charles Community College

“…a nice training option for almost any need. Their complete Microsoft Office package is by far the best deal on the market.”
— Technical Assistance Program
Purdue University

“Any instructor teaching classes on Windows or Microsoft Office will definitely want to give serious consideration to this important collection of titles that will definitely fit well into their classroom learning.”
— Dale Farris
Golden Triangle PC Club

“The materials are exceptional – I am so excited about using them! Thanks to you and your team for doing this wonderful work!”
— Shannon Coleman
Learning Post Ltd.

---
Welcome to Microsoft Office 365!

Office 365 is the latest offering from Microsoft, just in time to fall in with the new era of online accessibility and productivity.

We have become accustomed to being able to video conference, network socially and use email facilities online, from anywhere, any time.

When it comes to creating a document, spreadsheet or presentation however, we’ve had to do so locally on a PC or laptop and then find a way to distribute, transfer or store those files via email or on some kind of storage device. Until now.

Office 365 is based on an online subscription facility that allows you to install applications, access, create, distribute and store documents from just about anywhere, anytime using a combination of application types. It’s easy to setup and has many advantages like multi-device installations, and access to free version upgrades.

In this chapter, we will introduce you to the options, and setup of Office 365.
Overview

Office 365 is an online subscription based facility that allows you to download, access, create, distribute and store Office documents and files from anywhere, any time. **NB:** To download the latest Office Applications, you will need to have a Windows 7 or 8 Operating System.

Choosing a Subscription

The first step to getting started is choosing the type of subscription you need. See **Table 1-1: Office 365 Home Subscriptions** and **Table 1-2: Office 365 Business Subscriptions** for a breakdown of the available options.

Each Subscription has different fees and payment options attached to it. To find out the exact costs and payment types for each, please refer to [www.office365.com](http://www.office365.com).

Table 1-1: Office 365 Home Subscriptions

<table>
<thead>
<tr>
<th>No. of Installations</th>
<th>Home Premium</th>
<th>Home &amp; Student</th>
<th>Home &amp; Business</th>
<th>Office Professional</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Up to 5 PCs/Macs&lt;sup&gt;1&lt;/sup&gt; plus select mobile devices&lt;sup&gt;2&lt;/sup&gt;</td>
<td>1 PC</td>
<td>1 PC</td>
<td>1 PC</td>
</tr>
<tr>
<td><strong>Annual Subscription</strong> (includes ongoing access to version updates&lt;sup&gt;3&lt;/sup&gt;)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Licensed for</strong></td>
<td>Home Use</td>
<td>Home Use</td>
<td>Home or Business</td>
<td>Home or Business</td>
</tr>
<tr>
<td><strong>Word, Excel, PowerPoint &amp; OneNote</strong>&lt;sup&gt;4&lt;/sup&gt;</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Outlook</strong></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Publisher</strong>&lt;sup&gt;4&lt;/sup&gt; &amp; Access&lt;sup&gt;4&lt;/sup&gt;</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>OneDrive</strong> (20Gb Storage Space)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Instant Access</strong></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Skype World Minutes</strong> (60 minutes/mth in 40+ countries)&lt;sup&gt;5&lt;/sup&gt;</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

**Trap:** There are some restrictions to which subscriptions and services can be combined when using Office 365. Find out more about these restrictions on the Office 365 website.

Exercise

- **Exercise File:** None required.
- **Exercise:** Go through some of the relevant subscription options and features.
**The Fundamentals**

<table>
<thead>
<tr>
<th>Table 1-2: Office 365 Business Subscriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>No. of Users</strong></td>
</tr>
<tr>
<td>------------------</td>
</tr>
<tr>
<td><strong>Office Applications</strong></td>
</tr>
<tr>
<td><strong>Hosted Email</strong> (50Gb storage space)</td>
</tr>
<tr>
<td><strong>Web conferencing, presence &amp; IM</strong></td>
</tr>
<tr>
<td><strong>OneDrive for Business</strong> (25Gb Space)</td>
</tr>
<tr>
<td><strong>Public Website</strong> (No additional hosting fees)</td>
</tr>
<tr>
<td><strong>Spam and Malware Protection</strong></td>
</tr>
<tr>
<td><strong>Community &amp; Phone Support</strong></td>
</tr>
<tr>
<td><strong>99.9% Uptime</strong></td>
</tr>
<tr>
<td><strong>Intranet Site</strong> (SharePoint)</td>
</tr>
<tr>
<td><strong>Office Web Apps</strong></td>
</tr>
<tr>
<td><strong>Site Mailboxes</strong></td>
</tr>
<tr>
<td><strong>Office Mobile for iPhone and Android Phone</strong></td>
</tr>
<tr>
<td><strong>Other Mobile Apps</strong></td>
</tr>
<tr>
<td><strong>Active Directory Integration</strong></td>
</tr>
<tr>
<td><strong>Advanced Email</strong></td>
</tr>
<tr>
<td><strong>eDiscovery Center</strong></td>
</tr>
<tr>
<td><strong>Advanced Voice</strong></td>
</tr>
<tr>
<td><strong>Business Intelligence</strong></td>
</tr>
<tr>
<td><strong>Enterprise Voice</strong></td>
</tr>
</tbody>
</table>

Trap: Older mobile software can be a problem! An Android device may be supported, but you need to have version 4.0 or higher to install Office.
The Fundamentals

Subscription Notes

Refer to the Superscripted numbers on Table 1-1: Office 365 Home Subscriptions and Table 1-2: Office 365 Business Subscriptions to see important notes and conditions applicable to the corresponding subscription features.

Table 1-3: Notes on Available Subscriptions

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><strong>PC/Mac</strong>: Current Office applications for Office 365 are Office 2013 for PC and Office 2011 for Mac. An active subscription will give you access to the latest versions as they become available.</td>
</tr>
<tr>
<td>2</td>
<td><strong>Mobile Devices</strong>: As of October 2013, Office Mobile can be installed on Android, Blackberry or iPhones, iPads and Windows Tablets. Office Mobile is available on Win phones and does not count towards the 5-device limit.</td>
</tr>
<tr>
<td>3</td>
<td><strong>Home Premium Annual Subscription</strong>: Windows 7 or 8 OS and Internet access required.</td>
</tr>
<tr>
<td>4</td>
<td><strong>Office Applications (Home)</strong>: Applications availability and features vary by device and platform. These specific applications are available on PC only.</td>
</tr>
<tr>
<td>5</td>
<td><strong>Skype World Minutes</strong>: Skype account is required and excludes special, premium and non-geographic numbers. Skype world minutes and calls to mobiles are for select countries only. For a list of regions and countries refer to the FAQ section on the Office 365 website.</td>
</tr>
<tr>
<td>6 &amp; 7</td>
<td><strong>Office Applications</strong>: Those framed in red are Windows client programs/features only, and cannot be used across devices.</td>
</tr>
<tr>
<td>8</td>
<td><strong>Hosted Email</strong>: You can connect the following versions of Outlook to use on your Hosted Email: for PC – the latest version of Outlook, Outlook 2010 or Outlook 2007 (limited functionality). For Mac – Outlook 2008 or Outlook 2011.</td>
</tr>
<tr>
<td>9</td>
<td><strong>OneDrive for Business</strong>: To be able to sync files with OneDrive for Business, you must have a subscription that includes Desktop versions of Office 2013 applications, or you must have Office 2013 Standard or the 2013 Professional suite installed on your PC (Subscriptions that do not include a Desktop version of Office, are Exchange OLP or Online Plan 1, Small Business and Enterprise E1).</td>
</tr>
<tr>
<td>10</td>
<td><strong>Other Mobile Apps</strong>: Apps that allow you to access, edit, view Word, Excel and PowerPoint on Windows phones, and apps like OneNote, OWA, Lync Mobile and SharePoint Newsfeeds, do not necessarily require a subscription, however they may have other requirements attached to them.</td>
</tr>
</tbody>
</table>

Tips:

- In addition to the Exchange Online subscription, there are also individual services for SharePoint and Lync Online. Kiosk plans are also available for “roaming” users.
- Two options are available for businesses requiring Office without IT services: Businesses who need applications for larger employee base and Office 365 ProPlus – a version offering additional capabilities.
- Plans that do not include a Desktop version of Office work with the latest PC version of Office, Office 2010 and Office 2007 (limited functionality) or Office 2008/2011 for Mac.
- With Enterprise plans you can combine E1, E3 and E4 Plans, the K1 plan (for Kiosk users) and the full range of standalone offers for individual services.
The Fundamentals

System Requirements

Microsoft has something called an Office 365 Client System Requirements Policy, and it lays out the requirements for the use of Office 365.

To really get the most out of Office 365, this policy states that you should have the latest apps, browsers, clients as well as mobile devices, and that you should install any updates and new versions of this software as soon as they are released.

New Office 365 features and functions may not work correctly on older versions of Office client or older Web Browsers.

Tip: When using Office 365 Pro Plus, updates and versions are automatically streamed to you.

The main two (2) requirements for Office 365 are:

- Current or immediately prior versions of Internet Explorer, Chrome, Firefox or Safari.
- Any installed version of Microsoft Office still in mainstream support. This includes: MS Office 2011 for Mac, MS Office 2007, MS Office 2010 and MS Office 2013 for PC’s.

Traps: Office products still in mainstream support do vary by country/region.

Each subscription has different operating system requirements. Some advanced options, tools and features within Office 365 do depend on certain operating systems – for instance, you cannot download the latest Office version unless you have Windows 7 or 8.

Certain browsers and Office clients may also have their own requirements which may be affected by which operating system you have.

When it comes to Office Web Apps, you will need to have the latest operating system on your phone/tablet in order to download, install and use any of the available Office Web Apps.

1. To find out exactly which requirements apply to your subscription choice and PC/Mac, refer to http://www.office.microsoft.com.

Exercise

Exercise File: None required.
Exercise: Discuss some of the relevant system requirements.

Figure 1-1: http://office.microsoft.com

Figure 1-2: Get started with Office 365
Background

Now that you know all the features and services available to you on an Office 365 subscription, you can get started with actually using your account.

Before you get going, let’s quickly take a brief look at how you would normally get to this point.

Sourcing and Setting up Office 365

1 Purchase an Office 365 Subscription/Trial

This can be done by an individual for Home use, or by a company representative within an Organization.

2 Email Setup

Business and Enterprise subscriptions have an Email Hosting feature. A Network Administrator would normally be responsible for setting this feature up so that users can make use of their company email address with the Hosting service on Office 365.

3 Setting up the Team

Again this will be the responsibility of the individual who purchased the subscription – for Home to add family members as users, or a Network Administrator to add employees as users so that the users can connect to and make use of all the features and services available on their chosen subscription. Administrators will send users their User ID and a temporary password to sign in with as part of this process.

4 Collaboration Tools

Depending on the subscription chosen, users can make use of the OneDrive to create, store, sync and share documents with others. They can connect to the SharePoint site (also known as Team sites or the Intranet) in order to co-ordinate and share companywide projects, documents, tasks and more. Last but not least, users can also access their documents and files from anywhere by using online tools like Mobile and Web Apps.

A Network Administrator would usually make sure that these features are also setup and accessible to users.

5 Software Installation

This brings us to where we will be starting. Depending on whether or not the subscription you’ll be using includes Office, software installations can be done by you, the user, or if you work for a large organization that is setup to do so, software installations may be arranged as a deployment, or a Technician may be sent to assist users with this process.

Exercise

- **Exercise File:** None required.
- **Exercise:** Go through the steps from purchasing a subscription to receiving a User ID and password.

Customise your Office 365 email

Change your email address to your own domain name.

Add users

The sooner you add team members the sooner you can start enjoying the full benefit of the collaboration tools built into Office 365.

Get started with collaboration tools

Work better together with OneDrive for Business, Office Web Apps and team sites.
The Office 365 User Account

At this point you would have received an email with a User ID and temporary password from your Network Administrator.

Now you can log in to your new User Account where all your new apps, software, tools and features are based and begin setting up your account and devices.

Accessing your Account

1. Open your Internet Browser, type https://login.microsoftonline.com/ in the address bar and press <Enter>.

   Tip: You will use this link a lot, so consider adding it to the browser Favorites on all your devices.

2. Enter your new User ID and temporary password in the fields provided.

3. Click Sign in.

4. You will need to update your password to replace the temporary one you were given.

5. Click save when you’re done.

The Getting Started Page

Depending on which subscription you or your company are using, the Getting Started page may look slightly different and the options and tools available will also differ.
**The Fundamentals**

<table>
<thead>
<tr>
<th>Table 1-4: User Account Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Settings</strong></td>
</tr>
<tr>
<td><strong>User Menu</strong></td>
</tr>
<tr>
<td><strong>Instructional Callout</strong></td>
</tr>
<tr>
<td><strong>Navigation Bar</strong></td>
</tr>
<tr>
<td><strong>Getting Started pane</strong></td>
</tr>
<tr>
<td><strong>Tools</strong></td>
</tr>
</tbody>
</table>

**Change your Settings**

If you need to make any basic changes to your Office 365 Account, access your account settings and make the necessary changes.

1. On the User Account Getting Started page, click the **Settings** button and select **Office 365 Settings**.
2. Select one of the options and make your changes as necessary.

![Figure 1-8: Office 365 settings page](image)

<table>
<thead>
<tr>
<th>Table 1-5: Office 365 Account Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>me</strong></td>
</tr>
<tr>
<td><strong>software</strong></td>
</tr>
<tr>
<td><strong>password</strong></td>
</tr>
<tr>
<td><strong>contact preferences</strong></td>
</tr>
<tr>
<td><strong>language</strong></td>
</tr>
<tr>
<td><strong>get started</strong></td>
</tr>
</tbody>
</table>
Office for Desktop/Laptop

You have logged on to your new User Account, now it’s time to set up your software. Depending on the Office version you currently have installed, you may need to perform your desktop installation in one of two ways. Standard Desktop Installation (if you have the latest Office or no Office at all), or Desktop Setup (if you have Office 2007 or 2010).

Trap: When installing or accessing some Web apps, you may need a Microsoft account. An Office 365 Subscription provides you with a User account which gives you access to features and apps relevant to your subscription. A Microsoft account is an email address and password you use to sign in to other Microsoft services. If you use any of the following, you already have a Microsoft account: Hotmail, Outlook.com, Gmail, Yahoo, Xbox Live, OneDrive, MSN, Messenger and others.

Standard Desktop Installation

If you don’t have Office installed, or you have the latest version installed, you can use the Standard Desktop Installation instructions below. If this is not the case, refer to the Desktop Setup lesson that follows.

1. Click PC & Mac on the Getting Started pane.

2. Select your Language, your system version (32-bit is recommended) and click install.

3. You’ll be prompted to run or save the Setup files, select Run.

4. On the User Account Dialog box, click Yes to confirm.

   Depending on your connection speed, installation may take some time.

5. When installation is complete, a Setup Wizard will pop up, click Next.

   Follow the easy onscreen prompts and keep clicking Next in order to complete your Office setup.

   Tip: Remember options in the Wizard may vary according to the subscription chosen.

   You are now ready to begin using the latest Office products available with your chosen subscription.

Figure 1-9: Some services that make use of a Microsoft Account

Figure 1-10: Standard Desktop Software Installation

Figure 1-11: Installation Wizard
Desktop Setup

If you currently have Office 2007 or Office 2010 installed, you will need to first update Office so that you can save documents to the OneDrive and use Outlook with Office 365 for mail and other features.

1. Click the Settings button on the top right and select Office 365 Settings.

2. On the Settings page, select software.

3. Select desktop setup from the menu listed on the left.

4. Click set up.

5. You’ll be prompted to run the application, click Run.

6. A Sign in window will pop up when set up is ready. Sign in, using your Office 365 credentials.

   Office 365 will now check your system configuration. Depending on the speed of your system, this may take a while.

7. Once the configuration check is complete, the upgrade can begin. On the pop up that appears, choose which applications you’d like to configure by selecting the applicable checkboxes, then click Continue, to allow Office 365 to configure and update your system.

8. Click Yes on the confirmation dialog box.

9. Once you have reviewed and agreed to the service agreement, click I accept.

   The upgrade will begin.

10. Click Finish on the confirmation screen. You may need to restart your PC before proceeding.

   Your desktop should now be ready to install Office.

11. Back on your Office 365 User Account, select Office from the Software menu on the left and then follow steps 2 – 5 from the Standard Desktop Installation lesson above to install the latest Office version on your desktop.

Figure 1-12: Software Menu for Desktop Setup

Figure 1-13: Software Installation for Desktop Setup
Office for Mobile Devices

There are a few confusing terms relating to Office Applications in general. Phrases like: Office Mobile, Web Apps, Mobile Apps, Client Apps and Office Mobile. With so many different names, it can sometimes be hard to know what’s what and how it relates directly to you and Office 365.

Before we go any further, we’re going to have a look at the different types of applications not installed on your desktop, and how they may relate to you:

**Web App:** This refers to any application that uses a Web Browser as the client. (A “client” in layman’s terms is the channel responsible for delivering a service/application from a server.) So you could, as an example, use any device with an Internet connection to log on to your Office 365 Account and check your email, using the Outlook Web App from your User Account. Web Apps are also free!

**Mobile Web App:** This is basically the same thing as a Web App, except its specifically optimized for a phone, so the screen size is a lot smaller and the browser may work a little differently.

**Client App:** This is an application that makes use of onboard resources like memory or space on your hard drive to deliver a service/application from a server. Internet Explorer is a perfect example of a Client App.

**Mobile Client App:** This is a Client App optimized for use on a phone.

**Office Mobile:** This is the Office Suite optimized for phones and it requires an Office 365 Subscription. Although it has limited functionality, it’s compatible with the desktop version, so you can view and edit a PowerPoint presentation on your phone using Office Mobile, while retaining the content and format when working with the same file on a desktop.

So what types of applications does Office 365 make use of? It depends on which subscription you choose, but the idea is that Office 365 makes use of all the types for the specific reason of giving you access to as many of your documents and files from as many different devices as possible.

**Exercise**
- **Exercise File:** None required.
- **Exercise:** Discuss the different types of applications.
The Fundamentals

Mobile Installation

Once you’ve installed software on your desktop, you can set up Office 365 apps on your Smartphone as well. You need an iPhone, Blackberry, or an Android or a Nokia (Symbian OS) based device.

1. Open the Internet browser on your phone, type in www.office.com/business-apps in the address bar and select <Enter> or the relevant equivalent on your phone.

2. Select the app you wish to download from the list of available options for your device and click Install or the relevant equivalent on your phone and follow any onscreen instructions to complete installation.

You are now ready to use the app on your phone.

Trap: Even if you have a supported phone, in most cases, you need the latest version of the phone OS to install the apps on your phone.

Tablet Installation

You can also install apps on your tablet, depending on the subscription you have chosen. You will need an iPad, Windows RT device or Windows 8 Tablet.

1. Open the Internet browser on your tablet, type in www.office.com/business-apps in the address bar and select <Enter> or the relevant equivalent on your tablet.

2. Select the app you wish to download from the list of available options and click Install or the relevant equivalent on your tablet.

Follow any additional onscreen prompts to complete installation.

The app is now installed on your tablet.

Trap: Even if you have a supported tablet, in most cases, you need the latest version of the tablet OS to install the apps on your device. Office may not be available for all tablets.

Another way to Access the Setup on your Phone or Tablet: Log on to your User Account via your Internet browser and click phone & tablet on the Getting Started pane. Choose the type of phone or tablet that you have and click the applicable get app. Enter the email address that you have setup on your phone (or tablet) and click Submit. This will send the link for www.office.com/business-apps to your phone or tablet.
The Fundamentals Review

Quiz Questions

1. How many PC’s or devices may you install Office 365 Home & Business on?
   A. 2
   B. 1
   C. 5
   D. Unlimited

2. In order to use Office 365, you must have Windows 7 or 8 as your operating system (True or False?)

3. You will be able to download and install all the available apps listed under your subscription on your mobile/tablet devices (True or False?)

4. You can use Office 365 with PC and Mac (True or False?)

5. You will be able to download and install all the available apps listed under your subscription on your mobile/tablet devices (True or False?)
Quiz Answers

1. B. You can install Office 365 Home & Business on 1 PC only. If you want a subscription for Home use that allows you multiple device installations up to 5 PC’s, you’ll need to select Office 365 Home Premium.

2. False. Office 365 does support some previous versions and applications, however, if you want to download and install the latest Office applications from Office 365, you will need to have Windows 7 or 8 as your OS.

3. False. The apps from the subscription that you are able to install on your Mobile or Tablet devices will vary by device.

4. True. Office 365 is available for PC and Mac, however, not all versions of operating systems on these devices may be supported.

5. False. The apps from the subscription that you are able to install on your Mobile or Tablet devices will vary by device.
By now you should have a pretty good idea of what Office 365 is and what you need to do to get it set up.

Now it’s time to get stuck in and begin using Office 365. Using the Outlook Web App you can read and reply to emails, manage your calendar and contacts from anywhere.

All this can be done using Office 365 on a desktop, mobile or tablet device. Web apps are available currently for Outlook, Word, Excel, PowerPoint and OneNote.

In this chapter, we will show you how to access and use the Outlook Web App on different devices.
Setting up the Outlook Web App

The Outlook Web App is incredibly handy. It’s one of those apps you will probably find yourself using almost daily. It syncs your email, contacts and calendar, making it extremely easy to use your email from any device and any location, even if you’re offline.

It looks very similar to Outlook 2013, the only difference is that you do not have full “Backstage” functionality, so use is mostly limited to basic functionality in Email, Contacts and the Calendar.

Trap: Some app features in Outlook Web App are only available when using Exchange.

Desktop Set up

With just a few clicks, you’ll be ready to use the Outlook Web App from anywhere.

1. Sign in to your Office 365 User Account.
2. Click Outlook on the Navigation bar.
3. Select your Language and Time Zone from the drop down list provided and click save.

The Outlook Web App will open, ready for use.

Mobile Set up

Depending on your phone and office subscription, you can also install and set up the Outlook Web App on your Smartphone. Note: Instructions and commands may differ by device.

1. Open the Internet browser on your phone, type in www.office.com/business-apps in the address bar and select <Enter> or the relevant equivalent on your phone.
2. Select the Outlook Web App and click Install or the relevant equivalent on your phone.

Follow any onscreen instructions to complete installation.

3. Enter your email Address and password on the sign in screen and click sign in.

4. Follow any additional onscreen instructions or prompts. You will also have the opportunity to enter a 4-digit pin number for extra security on your phone.
**The Outlook Web App**

**Tablet Set up**
If you have a supported tablet device, you can install the Outlook Web App on your tablet as well. **Note:** Instructions, prompts and commands may differ from tablet to tablet.

1. Open the Internet browser on your tablet, type in [www.office.com/business-apps](http://www.office.com/business-apps) in the address bar and select <Enter> or the relevant equivalent on your tablet.

2. Select the Outlook Web App and click Install or the relevant equivalent on your tablet.

   Follow any onscreen prompts to complete installation.

3. Enter your User ID and password on the sign in screen and click sign in.

4. Follow any additional onscreen instructions or prompts until you reach the point where you can click go to inbox.

![Figure 2-3: Outlook Web App Tablet Set up](image)
The Outlook Web App

**Outlook Web App for Email**

As mentioned before, using the Outlook Web App works in a similar way to Outlook 2013. You’ll see that whether you’re using the app on a desktop, tablet or mobile phone, the layout and functionality are pretty similar. The major difference lies in that Web Apps for phones and tablets are optimized for touch.

1. Launch the app from your mobile/tablet device, or log on to your User Account from a desktop.

   **For Desktop Users:** Once on your User Account, click Outlook on the Navigation bar.

2. Use the available menu options specific to your device in order to perform actions in your Email account, e.g. read, reply, forward, delete or flag messages etc.

   **Tip:** The menus and actions available on specific devices may be different. If you’re using a tablet/mobile device, you are most likely using your finger to tap or swipe your selections, whereas desktop users would be using a mouse to click through their options. See Table 2-1: Device Specific Menu Options for Email for an idea of what some of the available basic menu options on Tablet and Mobile devices look like.

**Exercise**

- **Exercise File:** None required.
- **Exercise:** Send an email to your neighbor using the Web App.

Open the SharePoint invitation email, go to the site and follow the site so that you can access it from your new User Account. Delete the email when you’re done.

---

**Table 2-1: Device Specific Menu Options for Email**

<table>
<thead>
<tr>
<th>Tablet:</th>
<th><strong>Figure 2-4:</strong> Outlook Web App Inbox on Desktop, Mobile and Tablet</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Navigation button" /></td>
<td>Use the Navigation button to switch between Email, Calendar, Contacts and Options. Select and hold this option to activate Voice input.</td>
</tr>
<tr>
<td><img src="image" alt="New button" /></td>
<td>New</td>
</tr>
<tr>
<td><img src="image" alt="Search button" /></td>
<td>Search your email</td>
</tr>
<tr>
<td><img src="image" alt="Check for mail button" /></td>
<td>Check for mail</td>
</tr>
<tr>
<td><img src="image" alt="View email message in full screen mode" /></td>
<td>View email message in full screen mode</td>
</tr>
<tr>
<td><img src="image" alt="See more actions and options button" /></td>
<td>See more actions and options</td>
</tr>
<tr>
<td><img src="image" alt="Collapse/Expand specific section of screen button" /></td>
<td>Collapse/Expand specific section of screen</td>
</tr>
</tbody>
</table>

---

**The Outlook Web App**
Delete message

See more actions and options

Reply, Reply to all, or Forward a message

Phone:

Use the Navigation button to switch between Email, Calendar, Contacts and Options. Select and hold this option to activate Voice input.

New

View Folder list

Search your email

See more actions and options
The Outlook Web App

**Outlook Web App for Calendar**

Using the Outlook Web App, you can also manage your calendar – make appointments, set reminders, create multiple calendars, link and share calendars with others.

1. Launch the App from your mobile/tablet device, or log on to your User Account from a desktop and then:
   - **For Desktop Users**: Once on the User Account, click Calendar on the Navigation bar.
   - **For Mobile/Tablet Users**: Select the Navigation button on your screen and click the Calendar icon on the Navigation menu.

2. Use the available menu options specific to your device in order to perform actions in the Calendar, e.g. view, create, edit, delete appointments, set reminders etc. See **Table 2-2: Device Specific Menu Options for Calendar** for an idea of what some basic menu options available in the Calendar on the Outlook Web App look like.

### Table 2-2: Device Specific Menu Options for Calendar

<table>
<thead>
<tr>
<th><strong>Tablet/Phone:</strong></th>
<th><strong>Option</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>![Calendar icon]</td>
<td>Use the Navigation button to switch between Email, Calendar, Contacts and Options. Select and hold this option to activate Voice input.</td>
</tr>
<tr>
<td>![Add icon]</td>
<td>New</td>
</tr>
<tr>
<td>![View icon]</td>
<td>Daily View</td>
</tr>
<tr>
<td>![View icon]</td>
<td>Weekly View</td>
</tr>
<tr>
<td>![View icon]</td>
<td>Monthly View by Week</td>
</tr>
<tr>
<td>![View icon]</td>
<td>This Month</td>
</tr>
<tr>
<td>![View icon]</td>
<td>See more actions and options</td>
</tr>
<tr>
<td>![View icon]</td>
<td>Collapse/Expand specific section of screen</td>
</tr>
<tr>
<td>![View icon]</td>
<td>View Today</td>
</tr>
</tbody>
</table>

**Exercise**

- **Exercise File**: None required.
- **Exercise**: Open the Calendar from your desktop and familiarize yourself with the slightly different look.
Sharing your Calendar

You can of course share calendars in Outlook as well, but when using the Outlook Web App from your desktop, it works slightly differently and this is one of those features only available if you are using Exchange.

1. Log on to your User Account and click Calendar on the Navigation bar.

2. Click the Share button on the top right.

3. In the Share with field, enter the name of the user you want to share your calendar with, or their email address if they’re not in your address book.

4. Click the Permissions list arrow to select what the user can see on your shared calendar.

5. Confirm a subject for the email the user will receive.

6. Use the Calendar drop down to select the calendar you want to share with the user and then click Send.

The user will receive an email with a link to your shared calendar.

Figure 2-6: Calendar Sharing dialog box.
The Outlook Web App

Outlook Web App for People

In older versions of Outlook, we used to refer to our people database, as Contacts, now we simply call the database, People.

Using the Outlook Web App you can add, edit and delete People as well as view available address books your organization may have set up.

1. Launch the App from your mobile/tablet device, or log on to your user account from a desktop and then:

   - **For Desktop Users:** Once on the User Account, click People on the Navigation bar.

   - **For Mobile/Tablet Users:** Select the Navigation button on your screen and click the People icon on the Navigation menu.

2. Use the available menu options specific to your device in order to perform actions with People, e.g. view, create, edit, delete contacts and address books etc. See Table 2-3: Device Specific Menu Options for People for some basic menu options available in People on the Outlook Web App.

Table 2-3: Device Specific Menu Options for People

<table>
<thead>
<tr>
<th>Tablet/Phone:</th>
<th>Use the Navigation button to switch between Email, Calendar, Contacts and Options. Select and hold this option to activate Voice input.</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>New</td>
</tr>
<tr>
<td>Search People</td>
<td>Search People</td>
</tr>
<tr>
<td>Edit</td>
<td>Edit</td>
</tr>
<tr>
<td>See more actions and options</td>
<td>See more actions and options</td>
</tr>
<tr>
<td>Collapse/Expand specific section of window</td>
<td>Collapse/Expand specific section of window</td>
</tr>
<tr>
<td>Schedule an appointment</td>
<td>Schedule an appointment</td>
</tr>
<tr>
<td>Send a message</td>
<td>Send a message</td>
</tr>
</tbody>
</table>

Exercise

- **Exercise File:** None required.
- **Exercise:** Open People from your desktop and familiarize yourself with the available options.

Figure 2-7: Mobile People View

The Outlook Web App

Table 2-3: Device Specific Menu Options for People
Outlook Web App Extras

Even though the Outlook Web App works a lot like the standard Outlook application, there are some features only available in the Web App and one or two overlapping features that may work slightly differently.

Let’s take a look at the most prominent ones.

Linking and Unlinking Contacts

It’s easy to lose track of a contact when you have hundreds listed and not having time to search through your contacts, you end up entering bits and pieces of different information for the same person.

Linking contacts allows you to consolidate all the information for someone on one business card. This is something only available on the Outlook Web App.

1. Launch the App from your mobile/tablet device, or log on to your User Account from a desktop and then:
   - **For Desktop Users:** Once on the User Account, click **People** on the Navigation bar.
   - **For Mobile/Tablet Users:** Select the **Navigation** button on your screen and click the **People** icon on the Navigation menu.

2. Select the contact you want to link.

3. In the Preview pane, select the **manage** link under linked contacts.

4. Contacts listed under Linked Contacts will show any current links made, and Suggested Links will provide potential matches to the contact.

   ✅ Another way of finding a Contact to Link: Start typing in the name of the contact you want to link in the **Find a Contact to Link** search box and click **<Enter>**, or the equivalent on your mobile/tablet device.

5. Select the contact from the Suggested Links or the Search results and click **link**.

6. Click **OK**.

   When you select this contact now, all their information will appear on one business card.

   ✅ **Tip:** When you link/unlink a contact, you may need to refresh the Outlook Web App on your device.

---

**Exercise**

- **Exercise File:** None required.
- **Exercise:** Create a new task called “Complete Sales Report” due the last Friday of this month. Set a reminder for the task for 1 week before the due date.
other devices before you will be able to see the newly created link.

7. To unlink a contact again, select the contact.

8. Click the Manage link in the Preview pane.

9. Select the contact from the Linked Contacts section and click unlink.

10. Click OK.

**Voice Input on a Tablet/Mobile Device**

The Outlook Web App also has a feature for Voice Input applicable to users with Windows 7 or Windows 8.

If your device is set up for Speech Recognition, you will be able to issue certain verbal commands like “New”, “Open”, “Close” etc. to navigate and perform actions in the Outlook Web App.

ℹ️ **Trap**: This feature is not available in all languages.

To access this feature on your tablet/mobile device, select and hold the Navigation button as shown in Figure 2-10: Voice Input for Tablet/Mobile devices.

**Creating Tasks**

Outlook 2013 has a lot more functionality available when it comes to working with tasks, but the Web App does offer limited functionality from a desktop device if your organization has been set up to support Tasks.

1. Log on to your User Account and click Outlook on the Navigation bar.

2. Click Tasks on the bottom left of your screen.

3. Click the new task button.

4. Enter a subject for the new task.

5. Select show more details to set reminders and other details relevant to the task.

6. (Optional) Add an attachment to the Task by clicking the Insert button.

7. Enter any notes or comments in the text box provided.

8. When you’re done, click Save.

![Figure 2-10: Voice Input for Tablet/Mobile devices](image)

![Figure 2-11: Tasks Dialog box for the Outlook Web App](image)
Managing the Outlook Web App

As mentioned previously, you may not have complete “Backstage” functionality in the Outlook Web App, but there are certain settings and options that you will be able to change and adjust to make integration and accessibility streamlined and effective according to your requirements.

Setting Desktop Options

1. Log on to your User Account and click Outlook on the Navigation bar.
2. Click the Settings button next to the User menu.
3. Select the setting you wish to change from the list provided and follow onscreen instructions to adjust the selected setting.

See Figure 2-12: Outlook Web App Settings menu for a list of available settings you can adjust within the Outlook Web App. (Available settings may differ by subscription type, device and use of Exchange.)

See Table 2-4: Outlook Web App Options for Desktop for a list of attributes you can change when selecting Options in the Settings menu.

<table>
<thead>
<tr>
<th>Account</th>
<th>Change options for “my account” and “connected accounts” here. Pop and IMAP settings can be found under the “my account” tab as well as most account related details. Under the “connected accounts” tab, you can set email forwarding and connect your Outlook Web App to other email accounts where required.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organize email</td>
<td>Here you can select from four tabs: inbox rules, automatic replies, delivery reports and retention policies.</td>
</tr>
<tr>
<td>Groups</td>
<td>Create distribution groups here that can be used in the address book for others to use, you can also join or leave existing groups.</td>
</tr>
<tr>
<td>Site mailboxes</td>
<td>Save and access content from shared projects in one place. Add the Site Mailbox app to the SharePoint site and select which of these mailboxes to list in Outlook 2013.</td>
</tr>
<tr>
<td>Settings</td>
<td>There are three tabs here: mail, calendar and regional. Add a signature under mail or make changes to the way the Outlook Web App deals with your mail, calendar and regional settings.</td>
</tr>
<tr>
<td>Phone</td>
<td>Select this option if you want to *sync the Outlook Web App with a mobile device. Block or remote wipe your phone from here as well. (*Available with Exchange only.)</td>
</tr>
<tr>
<td>Block or allow</td>
<td>Change the way Outlook Web App deals with your junk mail and blocked and safe senders.</td>
</tr>
<tr>
<td>Apps</td>
<td>Add and remove apps within Outlook like Unsubscribe and Action Items etc.</td>
</tr>
</tbody>
</table>
Setting Mobile/Tablet Options

You can also manage your Outlook Web App from a mobile/tablet device.

1. Launch the app from your mobile/tablet device.

2. Click the More actions button on your screen.

3. Select options.

4. Select the setting you wish to change from the list provided and follow onscreen instructions to adjust the selected setting.

See Table 2-5: Outlook Web App Options for Mobile/Tablet for a list of attributes you can change for your mobile/tablet device.

Another way to access your settings on a mobile/tablet device: Click the Navigation button on the bottom left of your screen and select the options icon. (This way may not be available on all devices).

Table 2-5: Outlook Web App Options for Mobile/Tablet

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic replies</td>
<td>Select this option if you are going to be out of the office, or on leave and you’d like to set up an automatic reply to be sent on your behalf while you’re away.</td>
</tr>
<tr>
<td>Time zone</td>
<td>If you are someone that does a lot of travelling, it’s important to make sure your time zone settings are always correct.</td>
</tr>
<tr>
<td>Email signature</td>
<td>Create an email signature to be sent out on your email messages.</td>
</tr>
<tr>
<td>Photo</td>
<td>Upload or update your profile picture – this picture accompanies any social/interactive applications you use, e.g. emails, social networking, Lync, User Account etc.</td>
</tr>
<tr>
<td>Passcode</td>
<td>Set a passcode to safeguard the Outlook Web App on your mobile device.</td>
</tr>
<tr>
<td>Contact sync</td>
<td>You can sync contacts to your mobile/tablet device to see caller ID and to use the device to search for contacts. This option is selected by default; if you uncheck the box, synced contacts will be deleted from the device.</td>
</tr>
<tr>
<td>Offline folders</td>
<td>The Inbox and Drafts folders will always be synced so that you can view them offline, but you can select to manually choose up to five (5) additional folders you want to sync offline.</td>
</tr>
<tr>
<td>Privacy and terms</td>
<td>Change the way the Outlook Web App treats privacy and cookies, third-party notices and view the app license terms.</td>
</tr>
<tr>
<td>Feedback</td>
<td>You have an opportunity to let Microsoft know how the Outlook Web App is working out on your mobile/tablet device.</td>
</tr>
</tbody>
</table>

Tip: To sort your Inbox folder by either date or conversation, click the More actions button and select sort by date/sort by conversation.
The Outlook Web App Review

Quiz Questions

6. Which device allows you to input a 4-digit pin code as extra security for access to the Outlook Web App?
   A. Desktop
   B. Tablet
   C. Mobile Phone
   D. B & C

7. The Outlook Web App looks and works exactly the same way as the Outlook application. (True or False?)

8. You can share your OWA Calendar even if you don't use MS Exchange. (True or False?)

9. The new reference to People, in newer Office versions replaces which previous feature?
   A. Business Cards
   B. Friends
   C. Address Book
   D. Contacts

10. How do you activate voice input on a mobile/tablet device?
    A. Click the More actions button, select options and then select settings.
    B. Click and hold down the Navigation button.
    C. Click the Navigation button, select the options icon and then select automatic replies.
    D. Just start talking, the mobile/tablet device will automatically register your voice.

11. You cannot sort your email by sender on a tablet device (True or False?)
Quiz Answers

6. C. All devices do offer facilities for password use to protect access to the Outlook Web App, however, only the mobile phone offers an extra layer of protection by implementing a 4-digit pin code as well.

7. False. Although there are many similarities between Outlook and the Web App version, the Web App version does not have complete “Backstage” functionality and the layout is slightly different.

8. False. Sharing your OWA Calendar, is something you can only do if you make use of MS Exchange.

9. D. Contacts is the old reference for what we now call People.

10. B. Select and hold down the Navigation button. Remember if your device is not setup for speech recognition, this will not work.

11. True. You can sort your email on a tablet device, but only by conversation or date, not by sender.
No more going in to the office at odd hours or waiting to use your personal device, now you can open and edit Office documents from anywhere, anytime. All you need is an Internet Browser!

Work with colleagues across different devices and store your files online so that even users that don’t have office can view the documents.

All this can be done using Web Apps. Web apps are available currently for Outlook, Word, Excel, PowerPoint and OneNote.

In this chapter, we will show you how to access and use some of these web apps on different devices.
Accessing Other Web Apps

So what’s the difference between a standard Office application and a Web App?

To access Word or Excel and other standard Office applications, you need to have purchased and installed the relevant software on a device. By launching the application on the device you are able to then create, edit and save files and documents locally.

With Web Apps, you don’t necessarily need a purchased license or installation. The Web application makes use of your Internet browser to open, allowing you to work with the file online.

Trap: When accessing a Web app from certain devices, you may need a Microsoft account. While an Office 365 Subscription provides you with an account which gives you access to features and apps relevant to your subscription, a Microsoft account is an account you use to sign in to other Microsoft services. If you use any of the following, you already have a Microsoft account: Hotmail, Outlook.com, Gmail, Yahoo, Xbox Live, OneDrive, MSN, Messenger and others.

Access from a Mobile or Tablet Device

1. Select the Web App icon from the mobile or tablet device menu.

2. Select Sign in.

3. You may be asked here for your Microsoft Account details. (Not to be confused with your Office 365 Subscription credentials).

4. Fill in the applicable User Name and Password.

5. Click Sign in.

You can now start using the app.

Tip: Once you’ve signed in the first time, you won’t have to sign in again to use the app. Just select the Web App icon to launch it as you would any other program or application.

Trap: Currently you can only view Word, Excel and PowerPoint Web Apps from your phone; you cannot edit files. To read Word and PowerPoint files from a phone, you will also need Internet Explorer 7 on Windows Mobile 7, or Safari 4 on iPhone 3G or 3GS.

Exercise

- Exercise File: None required.
- Exercise: Discuss the main differences between Web Apps and standard Office applications.
Using Other Web Apps

Access from a Desktop Device
Web Apps are aimed at mobile and tablet device users, as well as users who do not have Office installed, but need access to view and edit documents and files.

When your desktop isn’t close by and you don’t have a mobile/tablet device, having your Office 365 Account with Web Apps can be a very handy tool.

1. Open your Internet Browser, enter https://login.microsoftonline.com/ in the address bar and click <Enter>.

2. Enter your Office 365 User ID and password and click Sign in.

3. Use the buttons on the Navigation bar to select which type of app you want to access:
   - Click OneDrive to access documents or files stored on the organizational OneDrive.
   - Click Sites if you want to access your Team site and use Office web apps on SharePoint.

Using the Newsfeed
Unlike OneDrive and SharePoint, we have not dedicated a whole lesson to the Newsfeed, even though it can be considered to be part of the online collaboration tools offered in Office 365.

Newsfeed, “hosted” by the SharePoint feature in Office 365, is basically there to give you your own “expression” space.

With limited SharePoint functionality, you can add selected apps and keep up to date with what’s going on with others using the Newsfeed. You can create your own blog posts and view a summary of all the People, Documents, Sites and Tags you’re currently following from the Home page.

Tip: Your organizational OneDrive account is also available from this hub as a Document Library listed on the apps page.

1. To access your Newsfeed, log on to your Office 365 Account and click Newsfeed on the Navigation bar.
OneDrive

Enter OneDrive. Most of the documents and files you want to access, create, edit, store and share will probably come from your OneDrive.

Also referred to as the Cloud, your OneDrive provides you with online storage space for your documents and files and makes it easy to sync, share and collaborate with others.

Trap: Not all Subscriptions come with access to OneDrive, and if your subscription does include OneDrive, don’t forget to keep an eye on the available storage space, as space may be limited.

Depending on your Subscription, you may have two variants of OneDrive. OneDrive for personal use and OneDrive for Business. It’s important to understand the difference.

OneDrive for Business

The first variant is your organizational OneDrive. It’s hosted as a Document Library within the SharePoint feature of an applicable Office 365 subscription, or the latest version of SharePoint. When you use this OneDrive, you can create, store and access documents and files that can also be made available to others in your organization.

Trap: After placing or creating documents in the Shared with Everyone folder, it can take a while before the document becomes available to others.

1. Access this OneDrive by logging on to your Office 365 Account, or your organization’s SharePoint site, and click OneDrive on your Navigation bar.

OneDrive (Personal)

The second OneDrive account is your personal account. This account is meant for personal use and comes free with Outlook or a Microsoft Account. The documents and files you create and save here are only available to you and those you specifically share them with.

1. Using your Microsoft Account credentials to sign in – access this account directly via: https://onedrive.live.com/ or, click the Open, Save As or Share options on the applicable File tab, of the Office application you’re working in.

For the purpose of this guide, we’ll be focusing on OneDrive for Business.

Trap: Available features and options for OneDrive may not be the same, or available on some devices!
Using Web Apps on OneDrive

Having documents and files available on OneDrive can be a great advantage. Depending on the space you have available, you could even use OneDrive as a backup location for important documents/files, and of course you can access, create and share your files from anywhere.

**Upload a Document to OneDrive**

Uploading documents and files you need to OneDrive, means all you need to access them, is a supported device and an Internet connection.

1. Open your Internet Browser, enter https://login.microsoftonline.com/ in the address bar and click <Enter>.

2. Enter your Office 365 User ID and password and click Sign in.

3. Click OneDrive on the Navigation bar.

4. Click new document and select Upload Existing File.

5. Click Browse. Navigate to and select the file you want to upload.

6. Click Open, then click OK.

**Share a Document on OneDrive**

Place a document/file in the Shared with Everyone folder to share it with the rest of your organization. Any files outside this folder will have to be shared manually in order for others to access or see them. Here’s how:

1. Select the file you want to share by clicking the Open Menu button (…) for the file and select Share.

   ![Another way to select files on SharePoint:](image)

   Point your cursor at the file and select the tick that appears to the left. You can then select an action from the ribbon that will be applied to the selected files. Deselect files by clicking the tick again.

2. On the Share Dialog box, select Invite people or Get a link.

   Invite people: use this option for sending an email with a link to the document to users within your organization.

   ![Figure 3-11: Sharing a File](image)

**Exercise**

- **Exercise File:** Exhiler8_BusinessCard.pub
- **Exercise:** Upload the Exhiler8_BusinessCard file to OneDrive and manually share it with one other user.

Create a new PowerPoint presentation in the Shared with Everyone folder, entitled “New Event Portfolio”.

Apply the Ion Boardroom, Variant 3 theme to the presentation, then close it and return to OneDrive.
Using Other Web Apps

Get a link: use this option to generate links for editing or viewing the file, and then send the link to anyone you want to share the file with.

3. Make your selection and fill in the fields and options provided.

Create a New Document on OneDrive

Depending on your subscription and device capability, you can create new documents from anywhere using OneDrive Web Apps.

Trap: Remember Web Apps have limited functionality compared to their desktop counterparts.

1. On OneDrive, click new document and select the type of document/file you want to create from the available list of options.

2. Type a name for your new document in the name field and click OK.


4. Click the Username link (e.g. Bob Smith) at the top left of the screen to save, exit and return to OneDrive.

Another way to exit/close the Web App:
Click the File tab and select Exit.

Edit a Document on OneDrive

Not all devices are enabled for editing, but where applicable, this is a great tool to have.

1. On OneDrive, navigate to the document/file you want to edit and click the document/file name link to open it.

Another way to open a file/document: Click the Open Menu (...) button for the file you want to edit and select Edit. You can also select the document/file you want to edit, click the File tab and select Edit Document from the Open & Check Out group.

2. Click the applicable Edit tab and select the type of application you want to use for editing.

3. Make any changes necessary and click the Username link to save and return to OneDrive.
Use Search on OneDrive

It’s great to know that you can access, share and collaborate with others using online collaboration tools like OneDrive, but how do you find shared files and documents that others have created?

You wouldn’t necessarily want to send emails to everyone, or receive emails from others every time a file or document gets shared, so how do you find what you’re looking for?

1. Open your Internet Browser, enter https://login.microsoftonline.com/ in the address bar and click <Enter>.

2. Enter your Office 365 User ID and password and click Sign in.

3. Click OneDrive on the Navigation bar.

4. Click the list arrow in the Search box and select the scope of where you want to search:
   - **Everything**: Use this option to find shared documents or files.
   - **People**: Use this option to directly access the OneDrive of another person in your organization. (Only their shared details and files will be available.)
   - **Conversations**: Use this option to find specific conversations.
   - **This Site**: Use this option to search for keywords or phrases.

5. Once you’ve made your selection, type in the partial name of a file, or person, phrase or keyword in the Search box and click <Enter>.

6. Select the item you’re looking for from the results shown.
SharePoint (Team Site)

So we already know SharePoint “hosts” the Newsfeed, and OneDrive for Business hubs on the Office 365 account, but what exactly is SharePoint?

In its most basic form it closely resembles a glorified external hard drive mixed with the look and functionality of a website. Also referred to as Intranet or Team Site, SharePoint is mostly used by organizations to create websites. These websites can be dedicated to different departments, clients or projects to form a secure base where anyone, given access, can log in, organize and store shared information in many different forms.

To access a Team Site you will need to be given a link with a username and password from an authorized administrator, or you will need an Office 365 Account.

1. Open your Internet Browser, enter https://login.microsoftonline.com/ in the address bar and click <Enter>.

2. Enter your Office 365 User ID and password and click Sign in.

3. Click Sites on the Navigation bar.

4. Select the site link for the site you want to go to.

Exercise

- Exercise File: None
- Exercise: Have students look at the Team Site to familiarize themselves with how it looks.

Figure 3-17: Sites page on Office 365

Figure 3-18: SharePoint Home page
Using Web Apps on SharePoint

How your organization has setup SharePoint will determine what actions you can perform and how you perform them. Most organizations will be set up to require the checking in and out of documents, or there may be an approval process for uploading documents, so you will need to contact your SharePoint administrator to find out exactly how your organization has set things up on your Team Site.

Upload a Document to SharePoint

If you have the permission to do so, you can also upload documents and files to SharePoint so that others can access them.

1. Open your Internet Browser, enter https://login.microsoftonline.com/ in the address bar and click <Enter>.

2. Enter your Office 365 User ID and password and click Sign in.

3. Click Sites on the Navigation bar.
   
   **Trap:** Only sites you have “Followed” will appear here.

4. Select the link for your Team Site.

   The Team Site will open.

5. Navigate to the site or folder you want to upload a document to.

6. Click new document and select Upload Existing File from the list of options.

7. Click Browse.

   **Tips:**
   - If you have multiple files to upload and your site is set up to do so, you can click the available Upload files using Windows Explorer instead link. **Note:** you need to have selected the Keep me signed in checkbox when logging in, and the Team Site needs to be added to Trusted Sites in order to use this facility.

   **Another way to upload a new file:** Select and drag the file on your computer in Windows Explorer towards the new document or drag files here link. A Drop here... block will appear, release your mouse and the file/s will be uploaded.

---

**Exercise**

- **Exercise File:** Budget_VanderPelt.xlsx
- **Exercise:** Upload the Budget_VanderPelt.xlsx file to SharePoint.

Open it in the Web App and adjust the actual Photography cost to $1600, save your changes and return to SharePoint.
Using Other Web Apps

8. Navigate to and select the file you want to upload and click Open.

9. Click OK. The file is uploaded. Depending on the approval settings on your site, the document may not be available to others until it has been approved.

Create a New Document on SharePoint

As mentioned before SharePoint “hosts” OneDrive for Business, which means the look, feel and processes on the OneDrive are very similar to SharePoint. This applies to creating new documents as well.

1. Navigate to the site and folder you want to create a new document in.

2. Click new document and select the type of document you want to create from the list of options available.

3. Type a name for your new document in the name field and click OK.


5. To save your changes, exit and return to SharePoint; click the Team Site link on the top left side.

   Another way to save, exit and return to SharePoint: Click the File tab and select Exit.

Edit a Document on SharePoint

Editing files on SharePoint can be a bit trickier, depending on the way your Team Site has been set up.

For instance, you may have to first check out a document before you can edit it and check in the document again when you’re finished. Your organization may also have versioning in place.

1. Navigate to or search the site for the file you want to edit.

2. Click the file name link to open it for editing.

   Another way to open a file/document: Click the Open Menu (…) button for the file you want to edit and select Edit. You can also select the document/file you want to edit, click the File tab on the Ribbon and select Edit Document from the Open & Check Out group.
3. Click the **Edit** tab and select to either edit the file in the desktop version or the Web App. Make your selection as required.

**Tips:**
- If your organization uses document check out/check in, you’ll see a Check Out button under the Ribbon on the document you’ve opened. Selecting the Check Out button means that no one else can edit the file while you’re busy with it. You can make your changes as necessary, and when you close the file, you’ll be prompted to check in the document again. Follow onscreen instructions to make the updated document available to others again.
- If your SharePoint settings allow more than one person to work on a document at a time, more than one person can open a document without checking it out. When this happens, a pop up will inform you of who else is editing the document at the same time.
- Where an editing conflict occurs, the person who saves their document first will retain the original copy, while those who follow will be saved as “conflict” copies, e.g. CompanyLetterhead.docx (Bob Smith’s Copy). Users will have to discuss a solution with each other when this happens.

4. To save and exit, for:

- **Web Apps:** Make your changes as necessary and click the Username link to save and exit the Web App.

  **Another way to save and exit a Web App:** Click the **File** tab and select **Exit**.

- **Desktop Applications:** Make your changes as necessary, click **Save**. On the Save dialog box you can rename the file (if read only) or to replace the one currently in the destination folder; just click **Save** again.

---

**Figure 3-23:** Editing Status Notification (Web App)

**Figure 3-24:** Editing Status Notification (Desktop)

**Figure 3-25:** Editing in a Web App
Use Search on SharePoint

This is just another way Office 365 makes online collaboration easy. Because SharePoint “hosts” OneDrive and the Newsfeed, you can use the Search boxes on any of these “hubs” to find users, shared documents or conversations, even those that are not directly uploaded or captured on the specific hub.

1. Click the Search box list arrow and select the scope of what you want to search:
   - **Everything**: Use this option to find shared documents or files.
   - **People**: Use this option to directly access the OneDrive of another person in your organization. (Only their shared details and files will be available.)
   - **Conversations**: Use this option to find specific conversations.
   - **This Site**: Use this option to search for keywords or phrases.

2. Once you’ve made your selection, type in the partial name of a file, or person, phrase or keyword in the Search box and click <Enter>.

   **Tip**: To get the most accurate results, type the full name of what you’re looking for. If you don’t know the full name, don’t worry, the search results will pick up on any keyword or phrase; it may just take a little longer to get through all the results.

3. Select the item you’re looking for from the results shown.

---

**Exercise**

- **Exercise File**: None
- **Exercise**: Search for the New Event Portfolio presentation you previously created in the Shared with Everyone folder and open it in the PowerPoint Web App. Return to the Team Site.

---

**Figure 3-26**: SharePoint Search Scope options

**Figure 3-27**: Search Results on SharePoint
The Using Other Web Apps Review

Quiz Questions

12. Which of the following Web Apps are not available currently:
   A. Outlook
   B. Excel
   C. Access
   D. OneNote

13. There are two different types of OneDrives (True or False?)

14. Which search scope below is NOT available when using Search?
   A. People
   B. Conversations
   C. This Site
   D. Recent Documents

15. You only require a link, username and password to access and edit files on SharePoint (True or False?)

16. When creating a new file on SharePoint, you can select from available Web Apps, uploading an existing file, or you can create a new folder (True or False?)

17. You can use the Search box on SharePoint to find any shared file, even if the file was not directly uploaded or created on SharePoint (True or False?)
Quiz Answers

12. C. Access is not currently available as a Web App.

13. True. There are two different types of OneDrives, one for personal use included with a Microsoft account or Outlook and one for organizational use, included as a feature in Office 365.

14. D. Recent Documents is not one of the scope options when using Search.

15. False. A link, username and password may give you access to SharePoint but not necessarily enable you to edit all files. What you can access and edit will be controlled by your Team Site administrator and the permissions they give to you as a user.

16. True. Depending on your permissions, you will be able to create new documents using available Web Apps, upload files from your desktop or create new folders in SharePoint.

17. True. You can use the Search box on SharePoint to find any organizational user, conversation or shared file, even if the item was not originally captured or uploaded directly to the Team Site.
There was a time when many of us were attached at the hip to a diary or day planner. Then came Outlook Calendar and suddenly managing our appointments and days became a lot easier.

There’s a second group of people who may still be slightly attached to the idea of carrying around a notepad and pen – always ready to take notes, a license plate number, or write down something they need to do as it comes to mind.

OneNote was introduced to replace the notebook and pen and with most people either carrying around a tablet or smartphone these days, OneNote is even more relevant and easy to use.

It allows you to enter and sort any notes you may need to work with, whether it’s planning a family vacation, or creating a list of action items required for a work project.

In this chapter, we will show you how to access and use the OneNote Web App, on different devices.
The OneNote Web App

Setting up the OneNote Web App

Most “tech-savvy” people have left pen and paper behind long ago. Almost anything you need to do, you can now do electronically. Of course some people would argue the reliability of technology versus “hard copy”, but the convenience and capacity that electronic services provide these days are sometimes hard to argue with.

 Trap: Remember you may need Microsoft Account credentials to access or use this app.

Desktop Set up

OneNote 2013 is included in the latest Office version, so if your Office 365 Subscription includes Office, OneNote will already be installed as part of the desktop software installation you did right at the start of this guide.

1. To start using OneNote, launch the application from your desktop/laptop.

2. Click Sign In, enter your Microsoft Account credentials and click Sign in again.

   OneNote will open, ready for use.

Mobile Set up

1. Open the internet browser on your phone, type in www.office.com/business-apps in the address bar and select <Enter> or the relevant equivalent on your phone.

2. Select the OneNote App and follow onscreen instructions and prompts in order to download, install and open OneNote on your phone.
   (Instructions and options may differ by device).

3. Enter your Username and password, then click Sign In.

 Trap: OneNote Mobile does not currently support Syncing with SharePoint.
Tablet Set up

1. Open the internet browser on your tablet, type in www.office.com/business-apps in the address bar and select <Enter> or the relevant equivalent on your tablet.

2. Select the OneNote App.

3. Follow onscreen instructions and prompts to download, install and open OneNote on your tablet. (Instructions, prompts and commands, may differ from tablet to tablet).

4. Enter your Username and password, then click Sign In.

Figure 4-3: OneNote Console on a Tablet
Using the OneNote Web App

OneNote, an electronic version of a notepad, allows you to create notebooks, add pages, sections, links, pictures and tables to help organize and enhance your notes.

With Office 365 your Notebooks will also automatically synchronize, so whether you’re using your browser or desktop, your latest notes will always be available.

Create a New Notebook

To get started you first need to create a notebook. You can create Notebooks for family vacations, grocery lists, an event or project, and then add sections and pages within the notebook to help sort and arrange the notes you capture.

 Trap: Remember the OneNote Web App will not have all the features or functionality of OneNote 2013, and certain limited features of the App will not be available on every device.

1. Launch OneNote on your device, then:
   - For Desktop/Laptop Users: Click the Notebook list arrow and select Add Notebook.
   - For Tablet Users: Select the Notebooks icon and click Create Notebook.

 Another way to Create a New Notebook: If you’re on the move, you can also create a new Notebook from your OneDrive for Business account. Log on to your Office 365 Account, or your organization’s SharePoint site and click OneDrive on the Navigation bar. Select new document.

2. Enter a name for the new notebook.
3. Select a location for the notebook to be saved.
4. Click Create or your device equivalent.
5. You’ll be prompted to share the new Notebook if you intend to have multiple people working on the Notebook; select Invite people, otherwise select Not now.

Exercise

- Exercise File: None required.
- Exercise: Create a new notebook for the Van der Pelt Wedding from your desktop and save it to your OneDrive for Business account.

Rename the first section to “Music” then close OneNote.

Go online and use the Web App on your OneDrive for Business account, to add a new Page in the Music section, called “Live Band” and make a note to “book the band asap”.

Figure 4-4: New Notebook (Desktop)

Figure 4-5: Send To OneNote Tool
Add Pages and Sections

To help keep your notebooks organized, you can create different sections within a Notebook that has different pages in it. For instance, you have created a Notebook for a multi-city business trip – you could have a section for each city in your trip, and pages under each city for what needs to be done at each site.

1. Launch the OneNote App on your mobile/tablet device, or log on to your Office 365 Account from a desktop.

   - **For Desktop/Laptop Users:** Click OneDrive on your Navigation bar and select the Documents folder. Open the Shared with Everyone folder, or select the Notebook you want to work with from the available documents.

   - **For Tablet/Mobile Users:** Select the Notebooks icon and select the Notebook you want to work with.

2. Click Insert and select New Page or New Section in the Notebook group as required (available features may differ on your device).

3. Follow any additional onscreen prompts relevant to your selection in order to add the new page or section.

   - **Tip:** (Desktop) Right-click items for additional options.

Add Notes

Capturing notes in OneNote is easy. No saving is necessary, any notes you capture are automatically saved as you enter them.

1. Open the Notebook and select the Page you want to add a note to.

   - **For Desktop/Laptop Users:** Click where you want to insert text and type your note as required.

   - **For Tablet/Mobile Users:** Click where you want to insert text and type your note as required.

Click the Username link (e.g. Bob Smith) on the top left to exit OneNote and return to your OneDrive.

- **Another way to exit the OneNote Web App and return to OneDrive:** Click the File tab and select Exit.
OneNote Extras

In addition to the basic tasks you can perform on OneNote, there are some helpful features that you can use to help enhance your notes.

Add Links

Adding links in OneNote is done the same way you would in any other application.

1. Open the Notebook and select the Page you want to add a link to.
   - **For Desktop/Laptop Users:** Click where you want to insert the link.
   - **For Tablet/Mobile Users:** Click where you want to insert the link.

2. Type the link out, pressing <Enter>, or your device equivalent to activate the hyperlink.

   - **Another way to Add a Link:** If you are using the Desktop Web App or your device allows, you can also manually add a link. Click the Insert tab and click Link in the Links group. Enter a display name for the link, enter the link address and click Insert.

Add Pictures

Need ideas or inspiration, or maybe visual notes just work better for you. Whatever the reason, it’s easy to add pictures to your notes.

1. Open the Notebook and select the Page you want to add a picture to.

   - **For Desktop/Laptop/Tablet Users:** Click where you want the picture to be inserted, click the Insert tab and select an option from the Images group. Navigate to and select your picture, then click Insert. (Features or options may differ by device).

   - **For Mobile Users:** Click where you want the picture to be inserted, click the Camera icon and select Photo library to insert a picture you already have on your phone, or Camera to insert a new picture (features or options on your device may differ).

Exercise

- **Exercise File:** None required.
- **Exercise:** Discuss different ways these “extras” can help enhance notes for a project or list.

Figure 4-9: Manually Inserting a Link

Figure 4-10: Inserted Picture (OneNote Web App)
Add Tables

We all know how helpful tables can be when it comes to sorting and listing information, so being able to add tables in OneNote is a great advantage.

Tip: Excel elements you may add in OneNote 2013 will be stored in your Notebook, but not necessarily displayed when opening the Web App.

1. Open the Notebook and select the Page you want to add a table to.

   - For Desktop/Laptop/Tablet Users: Click where you want the table to be inserted, click the Insert tab and select Table from the Tables group. Use the table grid to select how many rows and columns you want your table to have. The Table will then be inserted.

     To modify the table, click the contextual Layout tab under Table Tools, or select and right-click items to use formatting tools available on the Mini Toolbar. On Tablets, click the contextual Table tab (features or options on your device may differ).

   - For Mobile Users: You will be able to view tables, but OneNote Mobile does not currently support the creation or modification of tables.
The OneNote Web App Review

Quiz Questions

18. When completing the desktop setup of OneNote, you will need to use your Office 365 Account credentials to sign in (True or False?)

19. If you add a new note, page or section in a desktop Notebook, you will be able to see it in the OneNote Web App (True or False?)

20. Which of the following features are not available on OneNote Mobile:
   A. Creating, deleting and renaming Notebooks
   B. Adding links
   C. Adding pictures
   D. Adding notes
Quiz Answers

18. False. You will need Microsoft Account credentials to sign in to the desktop version of OneNote.

19. True. Office 365 automatically synchronizes your Notebooks, so depending on the device you’re using, your latest notes will always be visible.

20. A. OneNote Mobile does not currently support the creation, deletion or renaming of Notebooks.